# CONTENTS

## INTRODUCTION

- Terminology and conventions 6
- About this document 7
  - About Help 7
- Preparing for installation on Windows computers 8

## COMMAND WORKSTATION

- Installing Command WorkStation, 9
- Configuring the connection to the CX3641MFP 11
- Using Command WorkStation, Windows Edition 14
- Additional features 15
  - User Authentication 15
  - Align Trays 15
  - Mixed Media 17
  - Virtual Printers 22
- Troubleshooting 24
  - Command WorkStation cannot connect to the CX3641MFP 24
  - Command WorkStation does not respond 25

## REMOTE SCAN

- Installing and configuring Remote Scan 27
  - Installing Remote Scan 27
  - Configuring Remote Scan 28
- Using Remote Scan 29
  - Retrieving scans using Docs 29
# HOT FOLDERS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installing Hot Folders</td>
<td>30</td>
</tr>
<tr>
<td>Using Hot Folders</td>
<td>31</td>
</tr>
<tr>
<td>Additional features</td>
<td>31</td>
</tr>
<tr>
<td>Preserve Document Setting</td>
<td>31</td>
</tr>
</tbody>
</table>

# WEBTOOLS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting up WebTools</td>
<td>33</td>
</tr>
<tr>
<td>Accessing the WebTools home page</td>
<td>34</td>
</tr>
<tr>
<td>Using WebTools</td>
<td>35</td>
</tr>
<tr>
<td>Home</td>
<td>35</td>
</tr>
<tr>
<td>Docs</td>
<td>35</td>
</tr>
<tr>
<td>Configure</td>
<td>35</td>
</tr>
</tbody>
</table>

# INDEX

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>INDEX</td>
<td>36</td>
</tr>
</tbody>
</table>
The CX3641MFP media pack includes a set of software utilities that allow you to manage the CX3641MFP, as well as the print workflow and content of jobs on the CX3641MFP.

This document provides an overview of how to install, configure, and use the following CX3641MFP utilities:

- Command WorkStation,
- Impose
- Remote Scan
- Hot Folders
- WebTools
Terminology and conventions

This document uses the following terminology and conventions.

<table>
<thead>
<tr>
<th>Term or convention</th>
<th>Refers to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Titles in <em>italics</em></td>
<td>Other documents in this set</td>
</tr>
<tr>
<td>![Help icon]</td>
<td>Topics for which additional information is available by starting Help in the software</td>
</tr>
<tr>
<td>![Tip icon]</td>
<td>Tips and information</td>
</tr>
<tr>
<td>![Warning icon]</td>
<td>Important information</td>
</tr>
<tr>
<td>![Caution icon]</td>
<td>Important information about issues that can result in physical harm to you or others</td>
</tr>
</tbody>
</table>
About this document

This document covers the following topics:

- **Command WorkStation**, Monitoring and managing the print workflow of jobs on the CX3641MFP.
- **Impose**: Applying imposition layouts to jobs for custom printing, binding, and cutting purposes (Windows only).
- **Remote Scan**: Initiating and retrieving a scan on the copier/printer from a remote computer on the network. Includes the Scan TWAIN plug-in module.
- **Hot Folders**: Storing and reusing frequently used print options when printing PostScript and PDF files on the CX3641MFP.
- **WebTools**: Managing your CX3641MFP remotely from the Internet or your company’s intranet.

For information about installing, configuring, and using ColorWise Pro Tools, see *Color Printing*.

About Help

Detailed instructions on using most CX3641MFP utilities are provided in Help. Wherever appropriate, this document refers you to Help for additional information and explains how to access Help for each utility.
Preparing for installation on Windows computers

Before installing CX3641MFP software on a Windows computer, note the following:

• To use Command WorkStation or ColorWise Pro Tools on a Windows computer, you must install Sun Java 5. If this file is not installed on your computer, the Command WorkStation or ColorWise Pro Tools installer automatically initiates the installation process. Follow the on-screen instructions.

**NOTE:** The recommended version of Sun Java is provided on the EFI Utilities (windows) CD.

• To install the CX3641MFP software, you must have Service Pack 4 installed on a Windows 2000 computer, and Service Pack 2 installed on a Windows XP computer. If you do not, a warning message alerts you to install the Service Pack.

Different versions of Sun Java can be installed on your computer. The CX3641MFP software automatically finds the correct version, so you do not need to uninstall other versions of Sun Java required for third-party applications.
Command WorkStation, allows CX3641MFP operators (or users with Operator or Administrator privileges) to monitor and manage the print workflow of jobs on the CX3641MFP. Command WorkStation, allows you to do the following:

• View the print status of jobs on the CX3641MFP.
• Hold, process, and print jobs.
• Override user-assigned print option settings.
• Preview the page content of a job.
• Reorder pages in a job and combine pages from different jobs.
• Create and use FreeForm master files for variable data printing.
• Archive job files.
• View job logs of recent print activity.
Installing Command WorkStation,

Install Command WorkStation, Windows Edition on a Microsoft Windows computer that has a network connection to the CX3641MFP. For a complete list of system requirements, see Welcome.

The installer for Command WorkStation, Windows Edition is provided on the EFI Utilities(windows) CD. In addition to the Command WorkStation software, the installer installs the Java files required to use Setup from Command WorkStation. For information about using Setup, see Configuration and Setup.

⚠️ Before you install the utility, read the guidelines described in “Preparing for installation on Windows computers” on page 8.

To install Command WorkStation, see the following procedure.

TO INSTALL COMMAND WORKSTATION,

1. Insert the EFI Utilities(windows) CD into the CD-ROM drive of the Windows computer.
2. Open the Command WorkStation folder.
3. Double-click the setup.exe icon.
4. Follow the on-screen instructions to complete installation.
Configuring the connection to the CX3641MFP

The first time you start Command WorkStation, you are prompted to configure the connection to the CX3641MFP.

You can also edit the configuration whenever there is any change to your CX3641MFP server or network, such as a changed server name or IP address. If you change CX3641MFP Setup information, do so before you reconfigure the connection. For information about reconfiguring the connection, see “To modify the configuration for Command WorkStation, Windows Edition” on page 13.

BEFORE YOU BEGIN

- Print the CX3641MFP Configuration page.

For instructions on printing the Configuration page, see Configuration and Setup.

This page contains information you need when configuring the connection, such as the IP address of the CX3641MFP. For TCP/IP installations, you can use the DNS name instead of the IP address. Make sure the CX3641MFP is already registered in a Domain Name Server (DNS) on your network. For more information, contact your network administrator.

TO CONFIGURE THE CONNECTION FOR COMMAND WORKSTATION, WINDOWS EDITION

1. Choose Start > Programs > Fiery > Command WorkStation to start the utility.

The Available Servers dialog box appears and displays all servers found in the local subnet.
2 If no CX3641MFP servers were found, click the Manual tab to search by DNS name or IP address. Type the DNS name or IP address and click Add to add the server to the Available Servers list.

If no CX3641MFP servers were found by Manual search, click the Auto Search tab, and then click Advanced to search by a range of IP addresses or by the IP address and subnet mask.

All available servers appear in the Available Servers list.

3 Select the CX3641MFP server that you want to use and click Add.

The selected CX3641MFP is added to the Login Server window.
4 Click the button to the left of the server name.
The Login dialog box appears.

5 Click the key to the left of Administrator, Operator, or Guest and type the appropriate password, if required.

6 Click Log In.
For information about setting passwords and the default Administrator password for the CX3641MFP, see Configuration and Setup.

Command WorkStation is now connected to the CX3641MFP.

To modify the configuration for Command WorkStation, Windows Edition

1 Start Command WorkStation.
The Login Server window appears.

2 Select the CX3641MFP server for which you want to modify the configuration and click Remove.

3 Repeat “To configure the connection for Command WorkStation, Windows Edition” on page 11.
Using Command WorkStation, Windows Edition

After you install and configure Command WorkStation, you can begin using it to monitor and manage jobs on the CX3641MFP.

For complete instructions on using the standard Command WorkStation features, see Command WorkStation Help. Additional features are described in the sections starting on page 15.

TO ACCESS COMMAND WORKSTATION HELP

1 Start Command WorkStation.

Select the CX3641MFP from the Server List dialog box and log on to the server.

For information about setting passwords and the default Administrator password for the CX3641MFP, see Configuration and Setup.

2 Choose Help from the Help menu.
Additional features

The following sections describe how to use additional features of Command WorkStation that are not discussed in Command WorkStation Help.

User Authentication

If user authentication has been enabled in CX3641MFP Setup, users may have to enter a user name and password in the printer driver to send a job to the CX3641MFP. Management of the job in Command WorkStation is determined by how you have logged on to the CX3641MFP, as Administrator, Operator, or Guest.

For information about setting up Users and Groups and enabling user authentication in the Configure WebTool, see Configuration and Setup. For information about User Authentication in the printer driver, see Print Options.

Align Trays

The Align Trays feature allows you to adjust the placement of text and images on the page so they are correctly aligned on a sheet of paper. This ensures that both sides of a duplex sheet have exactly the same alignment.

You can also perform tray alignment from the CX3641MFP scanner panel by choosing Tray Alignment from the Functions menu.

To perform tray alignment, you must do the following:

- Log on to the CX3641MFP with Administrator privileges and enable tray alignment in CX3641MFP Setup.
- Enable Tray Alignment in the Paper Source option bar of the CX3641MFP printer driver.
- Select the correct paper tray before printing.

**NOTE:** For Tray Alignment to work when printing a job, select the tray that you have aligned in the Paper Source option bar before printing. If you later print a job using the auto tray selection, the alignment does not work.

**To align text and images for printing**

1. In the Active Jobs window, select the connected CX3641MFP for which you want to perform tray alignment.

   If the Active Jobs window is hidden, choose Active Jobs from the Window menu to display it.

2. Choose Align Trays from the Server menu.
A dialog box containing the Tray Alignment options appears.

3 Choose the tray that you want to align from the Tray menu.

4 Choose the paper size loaded in the tray from the Media menu.

   NOTE: The alignment is specific to the combination of tray and paper size specified. If you align a given tray with Letter paper, and then load Legal paper in that tray, the alignment is wrong. You must perform a new alignment for each combination of tray and paper size.

5 In the Print Alignment Page area, select the Print Duplex option to print a duplex page, or clear the option to print a simplex page.

6 Click Print.

7 After the Alignment Page is printed, follow the instructions on the page.

   Fold the page exactly in half horizontally, unfold it, and then fold it in half vertically. When you unfold the sheet, observe that the fold lines cross three scales on three sides of the page. Determine which number on the scale each fold line crosses.

8 In the Enter alignment values area, enter the value that appears where the fold crosses each of the three scales, marked A, B, and C, for Side 1. If you choose to align for duplex printing, enter the values for the three scales on Side 2 of the page, as well.

   NOTE: If you enter different values in A and C, the image rotates, leading to uneven areas on printed output. If this occurs, enter the same value in A and C.

9 After you have entered the alignment values, click Apply, and then click Check Alignment to print the new alignment page.

10 To remove the alignments, select a tray and click Defaults in the Enter alignment values area.

11 Click Done.
Mixed Media

The Mixed Media feature allows you to define the chapter divisions of a job, print ranges of pages on varying types of media, insert blank media between pages, and insert tab media containing text labels.

The following guidelines and restrictions apply to Mixed Media settings:

• The Mixed Media dialog box restricts you from specifying settings that conflict with any media, page size, or finishing settings that have been specified for the job in the Job Properties dialog box or printer driver.

• When two or more Mixed Media settings are in conflict with each other, the Mixed Media dialog box highlights the setting names in red, signaling you to resolve the conflict.

• When you specify print options (in the Job Properties dialog box or printer driver) after specifying Mixed Media settings, certain print options may conflict with the page-specific Mixed Media settings. You must resolve the conflict by choosing different print options or removing certain Mixed Media specifications.

• Mixed Media settings affect the use of output color profiles when the “Use media defined profile” option is selected in ColorWise Pro Tools. For more information, see Color Printing.

• If counters are configured for the copier/printer, blank media inserted between pages count as printed pages.

Basic instructions for accessing and using Mixed Media are provided in Command WorkStation Help. Features specific to the CX3641MFP are described in the following procedures.

To define Mixed Media specifications

1 Select or right-click a spooled/held job in the Active Jobs window and choose Properties from the Actions menu, or double-click a job.
2 Click the Paper Source icon in the Job Properties toolbar and scroll down to Mixed Media. The Mixed Media dialog box lists any previously defined media settings and includes buttons for defining, modifying, and removing settings.

3 For Chapter Start Page(s), type the page numbers on which you want to start new chapter sections. Type page numbers as comma-separated values (for example: 4,9,17) to designate the start of each new chapter. This forces each starting page to use a right-side page, adding a preceding left-sided blank, if required.

**NOTE:** It is not necessary to type the first page, and page numbers refer to the numbering of the original document. If you use the Chapter Start Page(s) feature, all media specified in the Paper menu per chapter must share the same dimensions (for example, all Letter, all Tabloid, or all A4).

4 To apply finishing options (for example, stapling or sorting) to each chapter created using the Chapter Start feature, select the “Define Each Chapter As A Separate Finishing Set” option.

**NOTE:** Not all finishing options can be applied to chapters that contain mixed sizes of media (for example, Letter and A4).

5 To define properties for front and back covers, click Define Cover. For more information, see “To define cover media settings” on page 19.

6 To define properties for individual pages or page ranges, click New Page Range. For more information, see “To define media for specific pages” on page 21.

7 To insert blank pages, click New Insert. For more information, see “To insert blank pages” on page 21.
8 To modify or delete a current definition, select it in the Mixed Media Definition list, and click Edit or Remove.

If you click Edit, enter new settings for the definition and click Modify.

9 After you finish defining Mixed Media settings, click OK to close the Mixed Media dialog box and Job Properties.

The Mixed Media settings are applied to the job.

**NOTE:** You can save up to 100 different settings for the Selection list in the Mixed Media dialog box.

**TO DEFINE COVER MEDIA SETTINGS**

1 In the Mixed Media dialog box, click Define Cover.

The Cover Media dialog box appears.

![Cover Media dialog box](image)

2 To define identical front cover and back cover media, select the “Apply the same settings for both front and back cover” option. To define media settings for the front or back cover individually, select the Front Cover or Back Cover option.

3 Specify other settings as required.
4 For Cover Page Mode, define how you want the content printed on the cover. You can specify printing on the front side only, back side only, or both sides of the cover page.

The following restrictions apply to Cover Page Mode settings:

- If you specify Print on Front Only, you must set the Duplex setting to Off.
- If you specify Print on Back Only or Print on Both Sides, you must set the Duplex setting to either Head to Head or Head to Toe. The Duplex setting determines the orientation of the cover content.

5 Click OK to return to the Mixed Media dialog box.

Cover Media settings take precedence over settings defined in the Page/Page Range Media dialog box.
TO DEFINE MEDIA FOR SPECIFIC PAGES

1 In the Mixed Media dialog box, click New Page Range. The Page/Page Range Media dialog box appears.

2 Type pages and page ranges as comma-separated values (for example: 3,9–14,18).

3 Specify other settings, as required.

   If you assign a new media type to the back side of a duplexed sheet, a blank page is inserted to force the assigned page content to the front side of the next sheet.

4 Click Add Definition after each media setting you define.

5 Click Close to return to the Mixed Media dialog box.

TO INSERT BLANK PAGES

1 In the Mixed Media dialog box, click New Insert. The Insert Blank dialog box appears.

2 Indicate whether to insert the blank before or after the target page. Define the target page as either the first or last page in the document, or as a specific numbered page.
3 Specify other settings for the blank page.
4 Click Insert after each blank page you define.
5 Click Close to return to the Mixed Media dialog box.

**Virtual Printers**

Virtual printers give users a method of printing to the CX3641MFP using predefined settings to configure the print job. The CX3641MFP administrator can create virtual printers and publish them so that users can access them on the network. SMB, LPR and FTP services are supported.

**NOTE:** By default, three virtual printers are already set up to correspond to the print, hold, and direct queues. These virtual printers cannot be modified.

The administrator specifies job settings for the virtual printer. The administrator can apply an imposition template to a virtual printer. Imposition settings override job property settings.

The CX3641MFP Administrator can view the available virtual printers and published queues, publish a virtual printer, and delete, duplicate, or edit a virtual printer.

You must be logged on as an administrator to configure virtual printers.

---

**TO CONFIGURE A VIRTUAL PRINTER**

1 In the Command WorkStation Server menu, choose Virtual Printers.
2 Click New.
3 Specify the following:
   • **Virtual Printer Name:** Type an alphanumeric name (a maximum of 255 characters).
   • **Comments:** Add comments to help define the virtual printer for the user, for example, “duplex company brochure.”
   • **Printing:** Select one of the standard CX3641MFP actions available from Command WorkStation, including Hold, Process and Hold, Print, and Print and Hold.
   • **Use Custom Job Properties:** Access and choose Job Properties.
   • **Apply Imposition Settings:** Access and choose Impose settings.
   • **Allow User to Override Settings:** Specify whether the virtual printer settings override the print job settings, or whether the user can override the virtual printer settings.

**NOTE:** Only users with access to printer drivers with the Two-Way Communication feature enabled can see and override the job settings.

4 Click OK.
To manage virtual printers


2. Select a virtual printer in the list and click Edit, Duplicate, or Delete.

Note: Once a virtual printer has been created, its name cannot be changed, although the print settings can be changed.

Printing to a virtual printer using SMB

Virtual printers are published on the network. To print to a published virtual printer from a client computer over SMB, do the following:

To print to a virtual printer using SMB

1. Right-click Network Neighborhood or My Network Places, and select Find Computer or Search for Computers.

2. Type the name of the CX3641MFP you are looking for and click Search Now.

   If you cannot locate the CX3641MFP, contact your network administrator.

3. Double-click the name of the CX3641MFP to display published virtual printers.

4. Double-click the virtual printer that you want to connect to.

   You must install the printer driver from the EFI Utilities (windows) CD as described in Printing from Windows.

   The virtual printer appears in Settings > Printers and Faxes.

Printing to a virtual printer using LPR

To set up a virtual printer using an LPR connection, you must configure a standard TCP/IP port for LPR printing and install the CX3641MFP printer drivers. When you configure the port, select LPR for the protocol and type the name of the virtual printer for the queue name.

For information, see Printing from Windows.

Printing to a virtual printer using FTP

If enabled in Server Setup, the CX3641MFP can function as an FTP server.

For information about setup, see Configuration and Setup.

To print to a virtual printer using FTP, use your FTP client software and connect to the CX3641MFP as to any FTP server. Ask your network administrator for the following information:

- IP address or DNS name of the CX3641MFP
- User name and password, if required
- The name of the virtual printer
Troubleshooting

When troubleshooting basic connection and software problems with Command WorkStation, see the following sections. For additional troubleshooting information, see Command WorkStation Help.

Command WorkStation cannot connect to the CX3641MFP

If you cannot connect to the CX3641MFP or locate the CX3641MFP from your computer, contact the network administrator. The administrator may need to troubleshoot your network connections and check settings on the servers that you print to. If settings have changed, you may need to reconfigure the CX3641MFP (see Configuration and Setup).

If you can connect to the CX3641MFP with another utility, you may need to reconfigure the Command WorkStation connection to the CX3641MFP (see page 11).

If you configured the CX3641MFP and set up client computers and network servers according to the instructions in Configuration and Setup, print a Test Page. If you can print the Test Page but still cannot print a document from a remote computer, contact your network administrator to troubleshoot the network connection.

If you cannot connect and cannot print a Test Page, check the copier/printer touch panel for error information.
Command WorkStation does not respond

If Command WorkStation is unresponsive, use the following troubleshooting guidelines.

IF THE COMMAND WORKSTATION WINDOWS DO NOT UPDATE

1. Log off and then quit Command WorkStation.
2. Restart Command WorkStation or restart the computer.

   If the Command WorkStation windows do not update or no jobs are displayed, and the mouse has no effect (you cannot select a job or a window, use a right mouse command, or select a menu item), the CX3641MFP is offline or network communication has failed.

TO FORCE AN EXIT FROM COMMAND WORKSTATION

1. Press Ctrl-Alt-Delete and use the Program Manager to close Command WorkStation.
2. At the CX3641MFP, disconnect and reconnect the network cable, and then try printing a Test Page or Configuration page.
3. If printing fails, restart the CX3641MFP.
Remote Scan is a collection of software components that allow you to scan documents from the copier glass or through the copier/printer’s automatic document feeder (ADF) and send the scanned images to specific destinations. Remote Scan consists of the following components:

• **Scan to E-mail** allows you to send the scan file by e-mail as an attachment.

• **Scan to FTP** allows you to send the scan file to an FTP server.

• **Scan to Internet Fax** allows you to send the scan file to an e-mail address to be delivered as a fax.

• **Scan to Mailbox** allows you to send the scan to a mailbox on the CX3641MFP, from where it can be retrieved.

• **Scan to Disk** allows you to scan directly to any hard disk on the network, such as your local hard disk.

• **Scan to Hold queue** allows you to scan to the CX3641MFP Hold queue for document merging and editing.

• **Docs WebTool** allows you to retrieve scanned jobs from mailboxes on the CX3641MFP.
Installing and configuring Remote Scan

You can use Remote Scan with the following applications:

- Adobe Acrobat v5.05/6.04/7.0.5
- imageWARE Document Manager 2002 series V4 (Windows only)
- Adobe Photoshop v7.01
- Adobe Photoshop Elements v3.01
- Adobe Photoshop CS2

The following sections describe how to install and configure Remote Scan.

Installing Remote Scan

To install and use the Remote Scan plug-in module, you must have a Windows or Mac OS computer with a network connection. For detailed system requirements, see Welcome.

The installer for Remote Scan is located on the EFI Utilities(windows) CD.

Before installing Remote Scan, see “Preparing for installation on Windows computers” on page 8.

To install Remote Scan on a Windows or Mac computer, see the following procedure.

TO INSTALL FIERY REMOTE SCAN

1  Insert the EFI Utilities(windows) CD into the CD-ROM drive of the computer.
2  Navigate to the location of the EFI Utilities(windows) CD, and open the Remote Scan folder.
3  Double-click the Setup.exe icon (on Windows) or the installer icon (on Mac OS X).
4  Follow the on-screen instructions to complete the installation.

To install Hot Folders, see the following procedure.
Configuring Remote Scan

The first time you start Remote Scan, you must configure the connection to the CX3641MFP. Before you configure the connection, you must have the correct IP address. Make sure that the CX3641MFP is registered in a Domain Name Server (DNS) on your network. When you open Remote Scan, the Scan Configuration dialog box appears. For instructions on configuring the connection to the CX3641MFP for the first time, see “To configure the connection to the CX3641MFP” on page 28.

Complete instructions on configuring and modifying the connection to the CX3641MFP are provided in Remote Scan Help.

If you have previously configured a connection to the CX3641MFP, it appears in the main Remote Scan window, and you can immediately start to initiate a scan or retrieve any scans initiated at the copier/printer touch panel and use Remote Scan Help.

TO CONFIGURE THE CONNECTION TO THE CX3641MFP

1. When you start Remote Scan for first-time use, the Configuration window automatically appears. In the Server Name (or IP Address) text field, type the IP address or the DNS name of the Print Server.
2. Select Use Nickname to enter another name to distinguish the CX3641MFP. This name does not have to match the actual Server Name of the CX3641MFP.
3. Type the name of the device (3641A3) connected to the CX3641MFP.
4. Click the green arrow to add the CX3641MFP to My Fiery List.
5. Click OK.

TO ACCESS REMOTE SCAN HELP

1. Start Remote Scan or open the Remote Scan plug-in module.
2. Click the Help button.
3. Use the Contents, Index, or Search panes to navigate to the Remote Scan Help topics.
Using Remote Scan

With Remote Scan, you can initiate and retrieve scan files remotely. You can open the scan file in a host application, such as Photoshop, and send the scan file to a mailbox, the Hold queue, or an e-mail address. You can then retrieve files using Remote Scan, Docs WebTool, or Command WorkStation. All scans are stored on the CX3641MFP hard disk and retrieved through the network.

The following procedures describe how to use Remote Scan from Photoshop 6.0 and Photoshop 7.0.

**TO ACCESS REMOTE SCAN**

1. Start Photoshop.
2. If you are scanning a single original, place it on the copier/printer glass. If you are scanning multiple originals, place them in the ADF.
   - The copier/printer must be switched online to the network from the copier/printer touch panel display. For more information, see the documentation that accompanies the copier/printer.
3. Choose Import from the Photoshop File menu.
4. Click Remote Scan.
   - The Remote Scan window appears.
5. Use Remote Scan to initiate and retrieve the scan.
   - For complete instructions on how to initiate, send, and retrieve scans, see Remote Scan Help.

**TO INITIATE A SCAN USING REMOTE SCAN**

1. Start Remote Scan., start Photoshop, choose Import from the File menu, and then click Remote Scan 5.
2. Select the CX3641MFP in the Choose Device dialog box and click OK.
3. If you are scanning a single original, place it on the copier glass. If you are scanning multiple originals, place them in the ADF.
4. Select the Initiate tab.
5. Select the appropriate scan settings and click Send (Remote Scan application) or Acquire.

**Retrieving scans using Docs**

You can retrieve scan jobs in the CX3641MFP Mailboxes to your remote workstation using the Docs WebTool. For instructions on using Docs, see page 35.
Hot Folders is a utility that allows you to store and reuse frequently used print options when printing PostScript and PDF files on the CX3641MFP. With Hot Folders, you can do the following:

- Create special folders (hot folders) that assign specific print settings and print queues to jobs.
- Print jobs to the CX3641MFP by dragging and dropping them onto hot folders on your computer’s desktop.
- Monitor the status of jobs sent to hot folders.

Installing Hot Folders

The installer for Hot Folders is located on the EFI Utilities(windows) CD.

Before installing the utility, make sure you complete the preliminary procedure described on page 8.

To install Hot Folders on a Windows or computer, see the following procedure.

**To install Hot Folders**

1. Insert the EFI Utilities(windows) CD into the CD-ROM drive of the computer.
2. Navigate to the location of the EFI Utilities(windows) CD, and open the Hot Folders folder.
3. Double-click the setup.exe icon (on Windows) or the installer icon (on Mac OS X).
4. Follow the on-screen instructions to complete the installation.
Using Hot Folders

Complete instructions on how to use the standard Hot Folders features are provided in Hot Folders Help.

TO ACCESS HOT FOLDERS HELP

1 Start Hot Folders.
2 Choose Help > EFI Hot Folders Help.

Additional features

The following section describes additional features of Hot Folders that are not discussed in Hot Folders Help.

Preserve Document Setting

When you define Job Settings for a new Hot Folder and open the Job Properties window, the default for many settings is displayed as Preserve Document Setting. This setting allows you to keep the job properties you set when creating the original job in the application.
WebTools allow you to manage your CX3641MFP remotely from the Internet or your company’s intranet. The CX3641MFP has its own home page, where you can select the following WebTools:

- **Home** provides current information about the jobs processing and printing on the CX3641MFP.

- **Docs** allows remote users to access jobs on the CX3641MFP over the Internet or intranet.

- **Configure** allows the CX3641MFP Administrator to view and modify Setup options remotely from a Windows computer.
Setting up WebTools

WebTools are resident on the CX3641MFP hard disk and do not require special installation. However, WebTools do require initial setup by the CX3641MFP administrator.

To enable network users to access and use WebTools, the administrator must set specific options in Network Setup and Printer Setup. For information about these specific Setup options, see Configuration and Setup.

The administrator also must prepare each user’s computer to communicate with the CX3641MFP over the Internet or intranet.

To set up client computers to use WebTools

1. Enable TCP/IP networking.
2. Make sure that the workstation has a valid, unique IP address.
3. Make sure that a supported Internet browser is installed on the computer.
   For more information about supported browsers, see Welcome.
4. Make sure that Java is enabled in your Internet browser.

In addition, make sure that you have completed the preliminary procedures, as described in “Preparing for installation on Windows computers” on page 8.

**NOTE:** If the client computer is running Windows XP with Service Pack 2 (SP2) installed, Pop-up Blocker is turned on by default. With this function turned on, a warning message appears when you access WebTools, and your access to WebTools is denied. To gain access, do one of the following:

- Change the Pop-up Blocker setting by clicking the warning message and choosing from one of the selections that appears.

- Turn off Pop-up Blocker in Internet Explorer from the Tools menu or in Internet Options.

For more information, see Internet Explorer Help, or the documentation that accompanies Windows.
Accessing the WebTools home page

Use your Internet browser to access WebTools. For complete information about browser and system requirements, see Welcome.

1 Start your Internet browser.
2 Type the IP address or DNS name of the CX3641MFP.
   The CX3641MFP home page appears.
   If the home page for the copier/printer appears instead of the WebTools page, click the WebTools link.
3 Click the tab for the WebTool that you want to use.
Using WebTools

The following sections describe how to use the WebTools.

**Home**

Home lets you view jobs that are currently processing and printing on the CX3641MFP. Printing and processing information is updated every 30 seconds.

For complete instructions on how to use Home, see Home Help.

**Docs**

Docs allows you to access jobs on the CX3641MFP over the Internet or intranet. You can:

- Manage and distribute jobs in your mailbox.
  
  Mailboxes are set up in the Configure WebTool.

- Control and modify jobs.

- Submit jobs to the Print Server.

For complete instructions on how to use Docs, see Docs Help.

**Configure**

Configure allows the CX3641MFP administrator to view and modify Setup options remotely from a Windows computer. For information about using Configure, see *Configuration and Setup*.

Before using Configure, make sure you have completed the Configure preparation procedure described in “Preparing for installation on Windows computers” on page 8.

For complete instructions on how to use Configure, see Configure Help.
INDEX

A
ADF (automatic document feeder) 26
Adobe Photoshop, scanning with 29
Align Trays 15

C
chapter definition for jobs 18
Configure 35
configuring 33
Command WorkStation, Windows Edition 11
connection on Windows 28
server 35
virtual printers 22
WebTools 33
conventions 6
cover media 19

D
deleting virtual printers 23
DNS name 11
Docs webtool 35
Domain Name Server, see DNS name
drag-and-drop printing 30
duplicating virtual printers 23

E
editing virtual printers 23

F
Fiery utilities, configuring the connection on Windows 28

H
Home WebTool 35

I
icons
in documentation 6
installing
Command WorkStation, Windows Edition 10
Hot Folders 30

J
Java 10, 33
jobs
chapter definitions 18
cover media 19
mixed media definitions 17

M
media definitions 17
Mixed Media 17

P
paper definitions 17
printing
frequently used print options 30

R
remote setup 35

S
server setup 35

T
TCP/IP 11
terminology 6
tray alignment 15
troubleshooting
Command WorkStation, Windows Edition 24

U
user authentication 15
users and groups 15

V
virtual printers 22
configuring 22
printing to 23
W
WebTools 33
  Configure 35
  Docs 35
  Home 35
  home page 34